Magic xpi 4.5
Release Notes

General Information
Introducing Magic xpi 4.5
We are delighted to provide you with the new major release of Magic Software’s
Magic xpi Integration Platform. The new features and enhancements are designed to
improve your user experience with the new look-and-feel as well as provide additional
functionality for your integration projects.
Magic xpi 4.5 is based on Magic xpa 3.1.

Migrating from Magic xpi 4.1 to Magic xpi 4.5
The Migration wizard automatically opens when you open an existing .ibs file.
Note: If the object names in your projects are in the language of your locale (such as
flow names or variable names in German), the locale of the machine must match the
locale used in the project when doing the migration. In addition, the magic.ini file’s
[MAGIC_ENV]ExternalCodePage flag must also match the used locale.

Steps Required After Migration
uniPaaS steps and Component SDK steps that were created in uniPaaS need to be
migrated manually to Magic xpa.
Web Service servers need to be deployed manually after migration.
External files need to be copied to the new project's location according to the old
project's hierarchy.
The migration process does not change any .ini files or its values. To use new
values, after migration, delete or rename the old ifs.ini file and build the project. A
new ifs.ini file will be created with new values.
If you had logical names defined in your Magic.ini file (not in the ifs.ini file), when
migrating a project add the logical names (environment variables) to the Magic.ini
or ifs.ini file. If the environment variables are project specific, you can add them to
the project's ifs.ini file. For non-project specific environment variables, copy them to
the Magic.ini file. Note that Magic xpi 4.5 is project centric, meaning that the
Studio loads the environment variables from the ifs.ini file.
If the Invoke Flow utility uses an expression containing hard-code IDs, it might not
point to the correct ID after the migration process, since these IDs may change
during the migration. It is recommended to use the dedicated functions, such as
GetFlowID and GetBPID, which calculate the ID at runtime based on the flow or
business process name.
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If the SpecialExpReturnNull flag is not already present in the migrated project's
ifs.ini file, you should add it to that file's [MAGIC_SPECIALS] section and set it to Y
to maintain backward compatibility with projects created in earlier versions of
Magic xpi or iBOLT. This flag maintains backward compatibility when comparing
a variable that has a Null value to an empty value.
If your migrated project has any user-defined components, the folder containing
them must be copied from its old location to the new location. Any changes to the
Resource_types.xml and Service_types.xml files that are connected to user-defined
components must be done manually.
JD Edwards World resource definitions should be updated with a library if such
definitions do not exist.
The JD Edwards Enterprise One configuration has been simplified and now uses a
dedicated class loader. It is no longer required to list all of the jar files in the
Magic.ini classpath. If you are using the new class loader, make sure to exclude
the j2ee1_3.jar from the jar folder. Refer to the Configuring the JD Edwards
Enterprise One Connector topic in the Help for specific instructions.
Due to major changes in the Salesforce metadata API, you will have to reconfigure
the Metadata CRUD method's Update and Delete operations.

Licensing
To use Magic xpi 4.5, you need to obtain version 4.x licenses. To obtain Magic xpi
licenses, please contact your local Magic Software representative.

Prerequisite Changes
.NET Framework
The Studio module of Magic xpi is based on the .NET Framework. The following .NET
Framework requirements apply:
To develop an application using the Magic xpi Studio, you must have .NET
Framework V4.0 (or above) installed on your machine.
For Runtime, the Magic xpi In-Memory Data Grid requester requires .NET
Framework V4.0 (or above).

Studio Installation
The Magic xpi Studio is based on Microsoft Visual Studio, which cannot be started
from a network folder. Therefore, it is not possible to start the Magic xpi Studio from a
network folder.
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Internal Database Changes
Writing and reading from the internal database is done using JDBC and not by using
the Magic xpa gateways. Magic xpi provides the JDBC driver (JAR file) for MSSQL
databases. To work with any of the other databases:
1.
Copy your JDBC drivers to the following folder: <Magic xpi
2.

4.5>\Runtime\java\DatabaseDrivers.
Configure the database settings in the Runtime\config\datasource.xml file
to match your DBMS. Make sure that the driverClassName defined in the
datasource.xml is compatible with the JDBC driver.

4

New Features, Feature Enhancements and
Behavior Changes
New and Improved Studio
The new Visual Studio-based Studio offers an intuitive and user-friendly experience.
The new Studio offers a variety of enhancements, including:
Docking capabilities.
A MiniMap to enable you to navigate quickly within long or wide flows.
A Toolbox pane that replaces the Components pane. All the Magic xpi
components and utilities appear in this pane, grouped together under specific
categories.
A Solution Explorer that replaces the Navigation pane.
A dedicated Properties pane that displays the properties of whichever part of the
project that you are parked on.
A Settings dialog box that includes the Resource Repository, Service Repository,
and IFS Settings dialog box from Magic xpi 4.1. This also includes the Magic.ini
file settings. This can also be accessed as a stand-alone editor, allowing you to
configure your project without opening the Magic xpi Studio.
A combined search functionality. The Find Name and Text Search of Magic xpi
4.1 were combined into the Find Text dialog box.
The copy and paste mechanism has been enhanced, including the support of
multiple pasting of steps and branches.
Non-English characters can be used in the names of business processes, flows, and
steps, as well as in descriptions. The names of projects, resources, services and
variables can only be written in English characters or the language of your
machine.

Behavior Changes
In Magic xpi 4.1, since the Magic.ini file took precedence in the Studio and the
ifs.ini file took precedence in Runtime, you had to maintain your environment
variables in both files. Now, in Magic xpi 4.5, the ifs.ini file always takes
precedence over the Magic.ini file, both in the Studio and in Runtime.
The keyboard combination for opening an existing project is now Ctrl+SHIFT+O
instead of Ctrl+O. The keyboard combination for creating a new project is now
Ctrl+SHIFT+N instead of Ctrl+N.
Inserting a flow or business process is now done using the Project > Add menu.
The default project location is now under your My Documents directory, in the
Magic folder.
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Setting how the Studio opens is done using the At Startup drop-down list. This is
accessed by going to the Tools menu, clicking Options, and selecting Startup in the
Environment section. This is similar to the Startup As property that was available in
Magic xpi 4.1's Customize dialog box.
The disabling, enabling, and deactivating of individual flows is now done through
that flow’s Properties pane.
Flow IDs in Magic xpi 4.5 are unique to a specific project, whereas in
Magic xpi 4.1 flow IDs were unique to a business process.
The Clear Mode property has been moved to the Project Properties window, and
can now be used to clear ODS information only.
Defining a flat file structure is done using the List property.
The following functions were added to the Expression Editor:
o ClientCertificateAdd
o ClientCertificateDiscard
o RqHTTPHeader
o UTCDate
o UTCmTime
o UTCTime
If the Magic xpi Server does not succeed in executing a step before reaching the
retry limit, the last error received is now automatically held in the C.sys.ErrorCode
context variable. If you want to clear the error instead of holding it, you should set
the ifs.ini file’s StepRetryClearError flag to Y. In addition, you can control the delay
between retries with the ifs.ini file's StepRetryDelayTnSec flag.

Magic Monitor
The Magic Monitor now offers all of the monitor capabilities for Magic xpi,
including the new support for the Activity Log, ODS, and BAM.
In addition, Activity Log messages can now be filtered when working offline.
You can click the new Messages History Export button to generate and download
a zip file containing a CSV file that holds all the messages related to the selected
project.
The Magic Monitor lets you force the immediate invocation of a Scheduler on a
specific flow, without changing the next trigger invocation time, once the project is
running again. You do this by selecting Invoke from the Scheduler's context menu.
The Magic Monitor allows new drill-down capabilities based on the FSID, Root
FSID and Flow Request ID.

Behavior Changes
In the Monitor, during runtime, the server deletes all ODS records belonging to a
completed FSID. In Magic xpi 4.1, these records appeared even when they were
no longer active.
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BLOB variables in Save Message steps can now be saved to the file system instead
of the database. The FILELOCATION column in the ifs_actlog table stores the value
from the [MAGIC_IBOLT]ActivityBlobFileLocation flag concatenated with the file
name when the project loads. The BLOB will be shown in the Magic Monitor
whether it is saved in the BLOB variable or in the file system. If the BLOB is saved
in the file system, the Magic Monitor will search the BLOB according to the
FILELOCATION column. When clearing the Activity Log from the Magic Monitor,
these BLOBs will be deleted whether they are saved to the database or on the disk.

Enhanced Connector Builder
The SDK from previous versions has been enhanced. The new Connector Builder lets
3GL programmers build, distribute and sell professional looking connectors. The
Connector Builder offers:
The ability to combine steps and triggers in a single connector
Out-of-the-box support for the Magic xpi Studio utilities
Customizable UI configuration for both steps and triggers
Data Mapper support for a dynamic step
Java and .NET runtime technology
Runtime isolation via a class loader
Licensing
Encryption

Data Mapper Enhancements
JSON Support
The Data Mapper can now work with JSON schemas.

Default Database Schemas
You can now determine which database schema will be loaded by default from the
cache (offline) and which will attempt to connect to the database in order to refresh
its structure (online).
You can refresh multiple database schemas by clicking the
button on the toolbar
or by clicking the Edit menu and selecting Refresh Database Schemas.

WCF Client Connector
The WCF Client connector generates C# code to access .dll files and schemas for later
use during runtime. This new connector provides easy and secure access and
consumption to a large library of services based on this worldwide standard.
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Dynamics AX 2012 Connector
The Dynamics AX 2012 connector is now offered as a built-in connector in Magic xpi
4.5.

MQTT Connector
The MQTT connector lets you work with MQ Telemetry Transport (MQTT), a lightweight
network protocol used for publish-subscribe messaging between devices.

Dynamics CRM Connector Enhancement
The Dynamics CRM supports additional authentication types. It is now a .NET
connector for on-premise Dynamics CRM servers and not a Java connector as in
previous versions. For online servers, it is still a Java connector.
Note: When you set the Dynamics CRM resource's Secured Connection property to
Yes and the Deployment Type to On Premise, set the DCRMAD flag in the Magic.ini
file's [MAGIC_IBOLT] section to Y.

SAP R/3 Connector Enhancement
The SAP R/3 connector enables communication over Secure Network Connections
(SNC).

JD Edwards Enterprise One Jar Files
Magic xpi is now using a dedicated class loader for loading all of the JD Edwards
Enterprise One jar files. It is no longer necessary to specify these jar files in the
classpath (either the machine classpath or the Magic.ini classpath) and no longer
necessary to copy them to the Magic xpi folder. The JDE connector now has a
dedicated folder for all of its jar files. If you are using the new class loader, make sure
to exclude the j2ee1_3.jar from the jar folder.

Additional External Services
A Flow Enablement service. Now the flow enablement can be defined as an
external service and can be modified and affect a project without the need to
rebuild the project.
A Scheduler service. Now the scheduler can be defined as an external service and
can be modified and affect a project without the need to rebuild the project.

8

SFTP Support
Magic xpi 4.5 offers support for the SFTP protocol in addition to the FTP protocol.

Salesforce TLS 1.2 Support
Magic xpi now supports the TLS 1.2 encryption protocol for the Salesforce connector.

Windows® 10 Support
Magic xpi was tested and is compatible to work with Windows® 10.

An Additional Space and Processing Unit
In addition to the existing MAGIC_SPACE, Magic xpi now includes
A MAGIC_INFO space that holds the Activity Log as well as statistics for the
monitor and ODS data.
An MGMirror processing unit, which is responsible for managing the write
operation of the Activity Log and ODS data to the database.

Magic xpa User-Defined Functions
You can now use Magic xpa user-defined functions in Magic xpi.

Debugger Enhancements
The Breakpoints and Suspends pane is now accessible during development.

Behavior Changes
Reconnecting the Debugger in the Studio: In Magic xpi 4.5, the Studio will try to
reconnect when there are connectivity problems between the Debugger and the
runtime project, according to a number of rules, such as several retries and
timeouts. In Magic xpi 4.1, for these types of problems, the Studio terminated the
debugging session.
Starting the Debugger is done by pressing F5 instead of SHIFT+F7.
When a project is running in Debug mode and the Studio is terminated, after the
Studio stops publishing that it is alive, the running project will terminate internally.
This prevents projects in debug mode running without having a studio controlling
them. In addition, when attaching to a running project and moving it into Debug
mode, if the Studio stops publishing that it is alive, the project will move back to
production mode.
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Terminology Changes
The following terms were changed:
Services to utilities: This is referring to the Services that were in the Components
pane in Magic xpi 4.1.
The uniPaaS component has been renamed to the Magic xpa component.
The System i connector has been renamed to the IBM i connector.
The SugarCRM connector has been renamed to the Sugar connector.
The Always use the new Picture node property was renamed to Always Use
Custom Picture.
The Exception Handling Flow property in database destinations was renamed to
Error Handling Flow.
The project’s executable extension was changed from .ibs to .mgxpiproj.
Compound Level Computation is now called Multi Update.
Cross Reference has been renamed to Find Reference.

Removed Functionality
The following features are no longer supported in Magic xpi:
Rights Repository
Security Groups Repository
Users Repository
Project Packager
COM component: In migrated projects, during runtime, the COM triggers will be
removed.
EJB component: In migrated projects, during runtime, the EJB steps will be treated
as NOP steps and triggers will be removed.
Domino component as a trigger: In migrated projects, during runtime, the Domino
triggers will be removed.
W4 component: In migrated projects, during runtime, the W4 steps will be treated
as NOP steps and triggers will be removed.
ItemField component: In migrated projects, during runtime, ItemField components
will be removed.
Legacy monitor including the ifm.ini file
Text Area tool
The Find Reference feature is not available for resources and services. To find
where a resource or service is used, use the Find Text option on the current project.
WS bridge
SharedValGet and SharedValSet functions
Magic xpi 4.5 is no longer compatible with the Windows® 2003 operating
system. This is because, by default, Microsoft does not support .NET Framework
4.5.2 (required by Magic xpi 4.5) with the Windows® 2003 operating system.
The Project Rename option has been removed. To rename a project, you can use
the Save Copy As option instead.
Object names cannot contain any of the following characters: [space] ~ ` ! @ # ,
% ^ & * - = + ( ) { } [ ] | " ? / \ < > ; or more than one dot (.).
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Currently Not Supported Features
The following features are currently not supported in Magic xpi:
Import/Export
Printing a project
The Customize dialog box
UDDI Server
JSON schema elements that contain the word: not.
Topology and Business Process editors
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Fixed Customer Issues
QCR # Description
110227 In some cases, the JVM_ARGS= flag in the Magic.ini file did not work
properly if the Magic xpi installation path contained 18 characters.
114701 The XML Validation component failed to validate XMLs that were known to
be valid.
114722 When defining a Web service with an XML Document as the Argument
Type, elements were not shown when changing to a different schema.
114764 The Magic xpi Studio froze when a calculated value was entered in the
Data Mapper.
114773 In the Data Mapper, a Select query returned blank values from a table if a
WHERE clause in the query had a value in Hebrew and the code page
was set to 1252.
114803 The Debugger sometimes failed when a project contained only one thread.
114818 When using a certain Argument XML document file as an XML schema, the
elements were not shown.
115855 The Google Docs connector’s Upload Item method could not locate parent
folders by key.
117591 An error was generated when a variable in a WHERE clause was set to
null.
117872 When calling a Magic xpi program from Magic xpa, an error occurred.
117877 .NET components did not connect to the internal database upon startup,
causing the flow to crash.
118219 It was not possible to disable the Always Create Nodes parameter if the
Max Occurrences node property was set to 1 under certain conditions.
119409 When using the Directory Scanner component as a trigger, the wrong
trigger line number was given in the "Source directory does not exist" error
message.
119900 When using the ODBC DBMS, an error was generated under certain
circumstances when trying to insert data into the database.
120127 The BlobRemoveBOM function did not work with UTF8 BLOB flow
variables that resulted from a Data Mapper step.
120219 The UDSGetField function did not work with UDS BLOBs that were
received as arguments from a parent flow Data Mapper step via a call
flow.
120451 When the Data Mapper converted Numeric data to Alpha data, leading
blanks were generated.
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QCR # Description
120853 When running a Salesforce Query operation on a child object, there was
an error during runtime.
121263 Leading spaces were trimmed when selecting the Append Data check box
in the Data Mapper’s XML Destination Properties dialog box.
121447 Too many acknowledge messages per IDoc were sent when using
SAP R/3.
121465 The Magic xpi Monitor showed either corrupted information or no
information at all on a machine working with the Portuguese language.
121656 When working with the Email component as a trigger, emails could not be
retrieved from the mail box under certain circumstances.
121818 The SAP R/3 connector missed some segments when sending IDocs.
122039 The % character could not be used in a database password.
122055 The log4j.xml failed to work with the magicxpi.activity.flow.started and
magicxpi.activity.flow.stopped loggers.
122414 The config folder’s projectsStartup.xml.example file did not contain the
alternateHosts attribute.
122759 The SugarCRM V10 trigger retrieved information in an incorrect XML
format.
122767 The Salesforce setRefbyExternalId function did not work with numeric
values.
123162 The varchar(MAX) database field could not be updated with a specific
XML file under certain circumstances.
123171 When working with large projects, the build process sometimes took a
long time to finish.
123782 The STRFormat function removed commas from source strings erroneously.
123991 When the Data Mapper’s Destination database was not available,
connections were lost in specific scenarios.
124207 Spaces in Web service endpoints called by the
OverrideSoapSpyForIntegratedAuthentication flag were replaced by
percent signs (%), causing the call to fail due to missing text.
124284 When working with the SugarCRM trigger, an error was sometimes
generated when the trigger’s values contained an ampersand (&).
124567 When using the Data Mapper with an MSSQL database, NULL values
were not set correctly.
124736 An error log file (strerr.log) was created in the root folder when working
with the SugarCRM connector.
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QCR # Description
124905 The SugarCRM connector failed under certain circumstances.
125088 When using MSSQL 2012 as a database resource, Magic xpi sent the
wrong SQL statement after getting the list of tables.
125547 The Magic xpi 4.1 server crashed sporadically under certain conditions.
125662 When a Directory Scanner trigger contained several lines, one of the lines
would sometimes crash during production.
126490 After migrating a project from Magic xpi 3.4, the uniPaaS component’s
trigger argument values were wrong after several remote calls were made.
127013 It took several seconds to send an IDoc from Magic xpi to the SAP R/3
system in a specific project.
127814 When working with the Salesforce API version 32, geolocation types were
returned as objects instead of as strings.
128274 When working with Sugar 7.6, the Sugar connector generated an
unexpected error message under certain circumstances.
128591 Images embedded in the body of a mail could not be downloaded.
129470 Project migration from Magic xpi 4.1 to Magic xpi 4.5 failed under
certain circumstances.
129581 The filtered information in the Magic Monitor’s Activity Log was not
displayed according to the colors that were defined for it.
130395 When working with SugarCRM v7.6, an error was generated when
refreshing an XSD or when performing operations on Calls and Meetings
modules.
131001 There were many thread crashes in some projects.
131456 Magic xpi did not create valid XMLs in certain cases.
131485 Chinese characters were not shown when using data conversion tables.
131778 The Monitor’s Activity Log tab displayed information in the wrong order
when sorted according to ascending or descending values.
131950 When working with the SetHTTPHeaders function, it was not possible to
use a colon in the value.
132014 When working with the BAM utility, modifications to file extensions were
not saved.
132205 The SharePoint connector’s Query operation did not work with the TLS
protocol.
132791 The Exchange connector’s task query operation did not work when
applying the daylight saving fix on a Japanese machine.
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QCR # Description
133008 A Directory Scanner trigger with an FTP source did not work when the
FTP’s AS/400 attributes were configured in UNIX list format.
133768 The HTTP trigger generated a FIPS error message in the IIS requester.
134026 When the value of the <latestDateCovered> parameter in the trigger.xml
file was less than the current date, the Sugar connector trigger did not
work properly.
134029 When working with the V10 API, the Sugar connector could not query
Contact objects.
135190 When migrating a Magic xpi 4.1 project, the Condition property value of
a Call Flow complex node was removed.
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About Magic Software Enterprises
Magic Software Enterprises (NASDAQ: MGIC) empowers customers and partners
around the globe with smarter technology that provides a multi-channel user
experience of enterprise logic and data.
We draw on 30 years of experience, millions of installations worldwide, and strategic
alliances with global IT leaders, including IBM, Microsoft, Oracle, Salesforce.com, and
SAP, to enable our customers to seamlessly adopt new technologies and maximize
business opportunities.
For more information, visit www.magicsoftware.com.

Magic Software Enterprises Ltd provides the information in this document as is and without any
warranties, including merchantability and fitness for a particular purpose. In no event will Magic Software
Enterprises Ltd be liable for any loss of profit, business, use, or data or for indirect, special, incidental or
consequential damages of any kind whether based in contract, negligence, or other tort. Magic Software
Enterprises Ltd may make changes to this document and the product information at any time without notice
and without obligation to update the materials contained in this document.
Magic is a trademark of Magic Software Enterprises Ltd.
Copyright © Magic Software Enterprises, 2016

16

